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Introduction 
This document provides a high-level summary of the Expedition Flow 2005 SPac1 (EXP2005 SPac1) 
release. It includes a summary of the new features in this release, any authorization code changes 
required, any major installation changes, and any transitioning issues you should be aware of before 
installing. Additionally, any last minute issues found in the final stages of testing are included. 

This document is located on the top level of the CD and on SupportNet. Changes may be added to this 
document after the release. Refer to the Release Highlights documentation on SupportNet for the most 
up-to-date release information. 

New Features for 2005 SPac1 
Numerous customer-reported defect reports (DRs) were fixed in this release. Additional 
information on these DRs can be found in the EXP2005 SPac1 Release Notes on SupportNet.  

The following new features were also added: 

Constraint Editor System (CES) 

The following is a list of  new features in CES: 

� Constraint Groups. Constraint groups you to view a specific subset of the constraint in the 
nets, parts etc sheets in CES. An example of a pre-defined constraint group would be Net 
Properties, Simulated Delays or Delays and Lengths. The aim of these constraint groups is to 
allow you to work with a group of data rather than manage the complete rules spreadsheet. In 
the 2005.1 release, the designer has the ability to create their own constraint groups. From the 
Constraint Group list box, the designer will find the new option; ...Edit User Groups. The 
designer can then create their own groups with whichever constraints they wish. These new 
user groups will be added to the list box in alphabetical order.  

� Support For Embedded Passives. CES 2005.1 introduces the ability to enter clearance rules 
for Embedded Passives (EP). The designer is able to enter the clearance rules between both the 
resistor and mask objects to the other copper features in the design. The EP rules can be found 
in the clearance sheet in CES. 

� Rules for SMD Pads. The designer can now add clearance rules specifically the Surface 
Mount Device (SMD) pads in a design to both traces and vias. 

� Dialog Box Enhancements. There have been many enhancements to the CES dialog boxes for 
the 2005.1 release. All the dialog boxes listed below have been enhanced to allow you to re-
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size them. There have been other improvements to a number of the dialogs to make them more 
intuitive. The following is a list of dialog boxes affected 

• Variable list.  

- Made expandable. 

• IBIS library search path.  

- Made expandable. 

• Auto assign differential pairs.  

- Made expandable. 

• Edit Æ Design Preferences Dialog… Æ Power and ground.  

- Made expandable 

- Removal of index column. 

- Removal of description column. 

• Assign Physical Nets to Net Class.  

- Made expandable. 

- Set focus to wildcard field 

- Set default action to Find (binoculars) instead of OK 

• Assign Physical Nets to Constraint Class.  

- Made expandable. 

- Set focus to wildcard field 

- Set default action to Find (binoculars) instead of OK 

• Package Type Clearance Rules.  

- Expandable dialog 

- Eliminate index columns 

- Expand Package Type columns 

• Create Constraint Template.  

- Expandable dialog 

- Description is now multi-line 

• Select Constraint Template.  

- Expandable dialog 
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- Remove Purpose column 

- Add a multi-line display for Description field 

• Constraint Violations.  

- Expandable dialog 

- Use a list view instead of tree view 

- Add Next and Previous buttons 

- Violation summary 

• Setup Æ Options… Æ Column Fonts and Colors 

- Expandable dialog 

- New layout of existing option - Swapped axis of columns and rows 

� Dynamic Column Width.  The cells/column width have been enhanced so that as the designer 
types the column will grow to optimum size so that the data remain readable. This is especially 
helpful with the Formula column. 

Expedition 
� CMC (Copy Move Circuit)  

� MVOs (Multiple Via Objects)  

� EP (Embedded Passives) 

� Tuning on one side of a diff pair 

� Route Fences 

� Conditional splitting  

� Local Gloss 

� Tuning Iterations 

FabLinkXE 
Following are the new features in FabLinkXE 2005.1: 

� Silkscreen Generator – In previous releases the Silkscreen Generator was only available 
within a PCB database through Expedition PCB. With the 2005 release, FabLinkXE is now 
able to support both a Panel and PCB database in a standalone mode. The Silkscreen 
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Generator has now been added to the standalone mode of FabLinkXE and is available for both 
a Panel and PCB databases.  

� PDF Enhancements – There are several PDF Output related enhancements: 

o Mirrored output – If the design database is mirrored, through Display Control, the 
PDF Output file will also be mirrored. 

o Additional Paper sizes – European sizes have now been added. 

o Black and White only option – By default, the colors used in the design’s Display 
Control schemes are used in the PDF Output files. For plotting and printing to 
paper, the “Black and White Only” option alleviates the need to apply a different 
Display Control scheme within the design. 

o Individual Detail Views – In previous releases, PDF Output only supported “all or 
nothing” printing and plotting of Detail Views. There is now an option to select 
individual Detail Views for each PDF sheet. 

� Interactive update of board locations -  In previous releases of FabLinkXE, if the network 
location of a PCB database that was placed in the Panel design was changed, the next time the 
Panel was opened, FabLinkXE was unable to resolve the board instance(s) within the Panel. 
The only way to resolve this was to delete the board instance(s), Browse to the new network 
location and replace those boards within the Panel design. Now, on invocation, can simply 
Browse to the new location and the pathnames will be resolved interactively without having to 
delete and replace the board instances. 

� Update all design data - In previous releases of FabLinkXE, the only time that the board 
instance would be updated in a Panel was on invocation. This has now been enhanced as 
follows: 

o On invocation 

o On demand 

o On generating manufacturing outputs 

The above options now ensure that the board instance(s) data is always in sync or up to date. 
Rather than having to exit and re-invoke FabLinkXE and open the Panel design, now you are 
able to verify and accept any board level instance changes at any time in the Panel design 
process. This also facilitates a concurrent Board and Panel design process. 

� Dimensioning Enhancements – Dimensioning has now been enhanced to support board level 
objects in a Panel design. Previously you were unable to dimension say between a board and 
panel level object, or board to board level objects within a Panel.  This enhancement continues 
to support the associations between the board and panel level objects. 

� ODB++ Output – The two stage, ODBG plus ODBG>ODB++ post processor has now been 
replaced with a direct ODB++ output. This removes the dependency on a 3rd party translator 
and provides additional output capabilities that are supported by the Valor tools, such as 
“Full”, “Fab” and “Assy” modes. 
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� Automation Pro – Automation Pro support has been added for the following “batch engines”: 

o Gerber Output  

o NC Drill Output  

o DRC 

o PDF Output 

o Manufacturing Output Validation  

o Design for Fabrication (DFF) 

This will enable the batch engines listed above to be run external from the application, at the 
command level and through the use of automation scripts. 

� Embedded Component Support (FabLinkXE Pro only)– The 2005.1 release of Expedition 
PCB will deliver functionality for the design of Embedded Components. In order to fully 
support the manufacturing requirements, the following outputs and new functionality has been 
added to FabLinkXE Pro 

o GDSII Output  

o IPC-D-356-B Netlist Output – This is currently the only industry “standard” 
netlist that offers support for embedded component technology. 

o Mask Generator – The Mask Generator provides the ability to combine graphical 
database elements, using logical or Boolean expressions to create specific 
manufacturing data sets, such as AND, OR, XOR, add/subtract shapes (touching, 
crossing, enclosed by etc.) The resultant data may be written to a user-defined layer 
then manufacturing outputs generated from that data. Some examples of use of the 
Mask Generator include extracting different embedded component material on 
specific layers, creating di-electric openings of a particular size and extracting all 
soldermask pads and undersizing/oversizing for a manufacturing process and/or 
tolerance change, rather than having to modifying the library padstacks. 

� Design for Fabrication (DFF) Analysis Improvements - There are several DFF Analysis 
related enhancements: 

o Rule Areas and Window support – Much like Net Class and Clearance rules, 
DFF schemes may now be applied to Rule Areas. DRC windows may also be 
applied to DFF Analysis, rather than having to perform the analysis on the whole 
design. 

o Use defined limit for maximum number of Hazards – In previous releases, there 
was a hard coded 10K limit on the maximum number of Hazards. This meant that 
if, for example an incorrect rule set had been applied that resulted in bogus errors, 
the 10K limit would have to be reached before the analysis would stop. Now you 
may apply a different limit for each analysis operation, ensuring that a reasonable 
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limit may be set and not have to wait for an excessive number of hazards to be 
reached before completion. 

o Browse option for rule schemes – In previous releases, the DFF rule schemes 
could only be saved and/or retrieved either locally, with the design, or with the 
“system files, in the install directories. Now you may browse to any network 
location to both,  save new schemes and retrieve existing schemes. 

o Blank fields for Rules and Clearances – When entering values for each of the 
rules, previously you had to enter a value for all three fields: Severe, Moderate and 
Warning. Now you may just add the value for one or two fields rather than all 
three, significantly simplifying and the time taken for rule entry. 

o Review Hazards summary count – In Hazards Review when using the 
Hide/Visible options, a summary count will now be provided so that you can easily 
see the number of hazards of a particular analysis/rule that are hidden versus the 
total number for that analysis/rule. 

HyperLynx 7.5 
HyperLynx did not change for this release. 

I/O Designer 
The following are the new features for I/O Designer: 

� Synchronization Wizard. I/O Designer 2005.1 introduces a new mechanism to synchronize 
all data related to the FPGA that the I/O Designer database is opened for. The new 
Synchronization wizard that replaces the old Update wizard works both ways (import/export). 
It warns the designer when the design is out of date and suggests the next logical step 
necessary in the process to synchronize the entire design. 

� New Hierarchical reserved sheets mechanism. I/O Designer 2005.1 has a changed 
methodology to update the hierarchical schematics. Instead of trying to update the hierarchical 
schematics with a lot of limitations, it now creates reserved sheets that are only updated by 
IOD and in addition the designer can add their own hierarchical sheets with components that 
are not touched by IOD anymore.  

� Automatic instantiation of page borders. New functionality in I/O Designer 2005.1 enables 
the designer to specify a page border to be automatically added to the generated schematics in 
the DxDesigner flow. 

� HDL and PCB signal names and mapping. I/O Designer 2005.1 introduces the ability to use 
different signal name conventions for the schematic/pcb design and the HDL design. Each 
signal or bus can have a different name for the FPGA and schematic/PCB design. Existing 
FPGA’s and PCB’s can be mapped to each other. This new feature also introduces the ability 



 
 

Expedition Flow 2005 SPac1 Release Highlights, EXP2005 SPac1 7 
June 2006 
 

to have PCB only signals, and therefore connect configuration pins or power pins to them 
without the necessity to have the same signal in the HDL 

� Assignment enhancements. New features are added to assign busses pin by pin in an 
enhanced way or swap large groups of pins such as busses, banks or entire swapgroups. 

� Local Clocks and Clock regions. Beside the already known I/O Bank view in the device 
window, new views have been introduced to show local clocks or clock regions. 

� Lattice support. I/O Designer 2005.1 supports the latest available versions of all FPGA 
vendor tools such as Actel Designer 7.0, Altera Quartus II 5.1 and Xilinx ISE 8.1. New in 
2005.1 is support for Lattice (ispLever5.1). In addition to new library support the library sizes 
have been reduced also due to a new more compact format. 

� Timing constraints and CES support. A first step has been made in I/O Designer 2005.1 to 
bring timing closure between the FPGA and PCB world. This version introduces a new timing 
tab to enable the designer to enter any timing constraints to be synchronized with the FPGA 
constraint files and timing report files. The new integration between I/O Designer and CES 
makes sure that any pin properties (e.g. differential pairs, I/O Standards) are being kept 
consistent between the FPGA and PCB design flows.  

� New windows management system. Windows can be docked/undocked and free positioned 
inside or outside the main I/O Designer window as of version 2005.1. Also the ability to tab 
windows in order to save screen space has been introduced. 

Quiet Expert 
� Additional API Set.  A new API, qe_NetOverlap, has been added to Quiet Expert 

for reporting vertical overlap between two nets. The API returns results as a list of polygons 
where the overlap condition occurs.  

� Net Classification.  Net grouping has been improved to allow better classification of nets. In 
addition to classifying nets by assigning them to net groups (Clock, Power, Ground, or 
Unclassified), you can now designate nets as having one or more of the following electrical 
characteristics:  

o sensitivity to noise 

o generating noise 

o analog signal  

o low-power signal 

These net designations do not affect the net grouping, and a given net can be assigned more 
than one characteristic at a time.  
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� Various DR Fixes.  There are numerous DR fixes to the Quiet Expert engine and translation 
process. Additional information on these DRs can be found in the Release Notes on 
SupportNet.  

XtremePCB  
The following are the new features for XtremePCB: 

� Ability to turn off online DRC. 

� Ability to manipulate Embedded Passives (license dependant). 

New Features for 2005.05 
The following new features are available in this release: 

Constraint Editor System (CES) 

CES has been extended to support electrical constraints, enhanced physical constraints, and improved 
design flow integration. 

� Electrical CES 

- Define electrical constraints, such as simulated delays, simulated crosstalk, and overshoot and 
ringback. 

- Assign IBIS models, and construct electrical nets and identify differential pairs from IBIS 
model keywords. 

- Validate model assignments, looking for missing or mismatched models. 
-  Use the IBIS Model Wizard to quickly create or edit complex IBIS models. 
- Generate trace model schematic in ICX Pro Explorer for solution space analysis and define 

constraint templates. 
- Define simulation settings and driver stimulus. 

� Enhanced Physical Constraints 
- Minimum, maximum, and matched length or Time-of-flight rules directly on electrical nets 

with series devices. 
- Pin-set topologies for automatic virtual pin insertion, placement, and trace balancing. 
- Trace width and layer overrides for pin-to-pin segments. 
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- Maximum length on restricted layers specified by net or constraint class. 
- Package-type to Package-type clearances. 
- Noise rules (parallelism and crosstalk) can be specified for constraint classes. 
- Package Pin Length defined in spreadsheets and factored into length tuning/hazards 

calculations. 

� Improved Design Flow integration 

- Supports new DxDesigner-CDB-Expedition design flow. 
- Now supports XtremePCB. 
- Define constraints on Expedition layout templates. 
- Synchronize net class constraints without full annotation cycle. 

DMS Librarian 
The existing Library Manager application, that is used to manage Central Libraries in the Expedition 
flow and for the Design Capture/Expedition PCB tool combination, has been extended (via the DMS 
Libr. Mgmt. Add-on Ap SW PN 226377) to support a transparent integration to DMS. This extended 
version of Library Manager is accessible by selecting “DMS Librarian” from the Windows Start Menu 
or running “DMSLibrarian” from the command line. The major benefits of DMS Librarian are: 

� DMS Librarian is an extension of Library Manager, which enables you to have the full benefit 
of DMS library management while using your accustomed library management environment. 
Managing libraries becomes easy, and you have the full value of data management without 
having to be concerned with the details.  

� Easy, “next-step” migration to full part request process (see Librarian Flow Manager)  

� While all Library object editing functionality has moved from dmsDesktop to DMS Librarian, 
DMS Librarian provides access to dmsDesktop for queries, component editing, etc.  

�  DMS Librarian includes a new tool called Update Production Library Wizard, which 
substantially simplifies the process of updating a production library in the Expedition 2005 
SPac1 flow. While existing scripts and processes remain fully compatible with DMS2005 
SPac1, you also gain the option of using a production library wizard: 

- Convenient interface assists you in selecting incremental or complete cache updates. 

- Status management helps automate behavior in terms of updating existing parts and 
synchronizing newly released ones.  

- By providing an automated wizard environment, the repeatability of cache updates is 
increased and the reliability of the process are greatly increased. 
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Note: Functionality similar to the Update Production Library Wizard was available in ISD2004 SPac2 
in the Library Manager to DMS Wizard. The Library Manager to DMS Wizard has been replaced by 
functionality in the DMS Librarian extension to Library Manager and the Update Production Library 
Wizard. This is supported by the DMS Libr. Mgmt. Add-on Ap SW (PN 226377) license. 

Documentation System Improvements 
InfoHubs are HTML information centers that organize your sets of documentation and provide 
information links into SupportNet. InfoHubs provide a combination of HTML- and PDF-based user, 
reference, process, and release information. Most of the HTML content is also available as PDF 
manuals. InfoHubs also include a local HTML search based on keywords, and an enhanced natural-
language search of SupportNet. 

InfoHubs are replacing the existing PDF- and Help-based documentation systems. This release is 
transitional. Some of the DxDesigner documentation is available as both HTML and PDF, while most 
of the Expedition and other product documentation is in PDF, WinHelp, and HTMLhelp. All of the 
documentation is migrated to the new InfoHub documentation system in future releases. 

You can access InfoHubs by loading the following file in your HTML browser: 

<install_dir>/2005EXP/docs/infohubs/index.html 
 
<install_dir> is the target directory where you install your Mentor Graphics application software. For 
more information, refer to the Managing Mentor Graphics PCB Systems Software manual available on 
the software release CD or via SupportNet. 

Note: Changes to the default setting for Internet Explorer on Windows XP SP2 prevents the InfoHub 
from functioning. A fix for this issue is provided in the Additional Release Notes and Workarounds 
section later in this document.  

DxDesigner 
The following describes the new features for DxDesigner: 

� DMS Connector. DMS provides seamless integration for the DxDatabook product. The 
following features enhance the DxDatabook capabilities in combination with a DMS Database: 

- Using the ‘native’ DxDesigner instantiation, update, and replace mechanisms leverage DMS 
content. 

- DMS component datasheets are available in DxDesigner.  

- Using http://<server>/DMSConnector URL link in DxDataBook, you can do a sophisticated 
part research in DxDatabook. An upgrade option is available to utilize this functionality. 
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� Expedition Integration . Integration with Expedition layout has been significantly upgraded 
through the use of  the Common Database (CDB) and CDB Compiler and Packager utilities 
(as used with Design Capture-Expedition) to generate, store and exchange design, connectivity 
and packaging data between DxDesigner and Expedition. The use of the CDB Compiler and 
Packaging utilities provides the DxDesigner-Expedition user with a much tighter level of 
integration between DxDesigner, Expedition and also with the Central Library since the 
packaging data is pulled directly from PDB (Parts Database). 

Expedition Design Configurations have been enhanced with new properties to support new 
CDB flow integration. New Tool Bar Menus have been added to support the CDB flow 
integration. New Device selection from the PDB menu and an “Add Device” tool bar have 
been added. You can search and add the Central Library PDB parts using this new feature. 

Note: To use the CDB integration, upgrade to the DxDesigner for Expedition or DxDesigner 
100 package.  Please contact your account manager or sales representative to learn how to 
upgrade to one of these packages.  

For more detailed information about Expedition integration, refer to the What’s New document 
on SupportNet. 

� Library Manager. Library Manager has been updated to support new features in the 
DxDesigner/Expedition flow. Refer to Library Manager later in this section. 

� Performance Improvements. This release provides improved performance and stability of 
DxDesigner on all platforms.  Some of the specific areas of improvement include: 

- Overall stability and memory usage by several applications. 

- DxDesigner startup time. A new option is available to suppress the loading of addins until the 
addin is needed.  This allows DxDesigner to start quickly in situations where the Project 
Navigator is not needed. Refer to the DxDesigner documentation for more information. 

- Project Navigator help tab performance.  The help tab no longer loads the contents of the 
individual help files, reducing the time it takes to display the top-level contents hierarchy. 

- Scout run time on large designs.  There is now a “No Verbose” check box in Scout that sends 
all error messages to the scout.err file, rather than to the Dashboard log window. 

� Location Map Support. Environment variables and/or location map entries can now be 
used as input to DxDesigner to resolve soft pathnames. A soft pathname contains a variable 
reference that points to a specific file system location. Soft pathnames can be used in .ini files 
(viewdraw.ini/draw.ini and files referenced by draw.ini) or some DxDesigner dialog boxes that 
require a pathname to a file or directory. 

� Find/Replace Enhancements. Find/replace is an extension of the existing select/replace. A 
new feature of find/replace is SCOPE. There are four scopes available for use while finding the 
objects. Find/replace supports regular expressions and works across a design, through 
hierarchy, and on any schematic object. 
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- Page:   Object is searched in the current sheet only. 

- Block:  Object is searched in all the sheets of schematic to which the current sheet belongs. 

- Here Down:  This is a hierarchical search/find. The object is searched in the current schematic 
and its underlying hierarchy. 

- Project:  This enables searching in all the schematics of current project. 

� Documentation Improvements - The following improvements have been made to the 
DxDesigner documentation set. 

- All DxDesigner procedure and reference information and is now provided in both Adobe PDF 
and HTML formats.  The HTML is optimized for online viewing with your browser, and the 
PDF is optimized for hardcopy printing. These new documents are designed to present 
information in a more complete and contextual format.  They include the following major 
documents, in addition to many other supporting documents: 

o     DxDesigner User’s Guide 

o        DxDataBook User’s Guide 

o        PCB Interfaces Guide 

o        DxDesigner Administrator’s Guide 

o        Scout User’s Guide 

o        DxDataManager User’s Guide 

o        Developing Scripts for DxDesigner Applications  

o        Simulation Netlisters 

o    Getting Started with DxDesigner 

o    Creating Variant Designs from DxDesigner 

o    DxDesigner Attributes Glossary 

o    DxDesigner DOS Utilities 

o    DxDesigner Schematic Translators 

o    DxParts QuickStart 

o    Getting Started in Hierarchical Schematic Blocks 

o    WIR Database Reference Manual 

o    Viewbase Reference Manual 
  

- All product documentation is consolidated into a single help system, called the InfoHub, that 
is HTML-based and viewable from your browser. You access the InfoHub, and all the 
installed product documentation (either HTML or PDF), through a single Help menu 
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selection from the Dashboard, from DxDesigner, or (in MicroSoft Windows operating 
systems) from the Start menu. A new search feature in the InfoHub enables you to search all 
locally installed documentation and Supportnet documentation. Because the InfoHub locates 
all documentation in one place, it is easier to locate the needed information. 

- The “Help” tab in the Project Navigator Tree window has been optimized to display help data 
more quickly, and it will display the same information as is displayed from the Help menu in 
DxDesigner. 

 

� Schematic Design and Editing Features. Several enhancements have been made to the 
schematic editing capabilities in DxDesigner.  They include: 

- A new bus contents file is now available for defining the signals that are included in a bus.  A 
short label can be placed on a bus that represents several buses and nets.  For example, a bus 
can be named “CONTROL”, and in the bus contents file, the bus can be defined as containing 
the signals “READ, WRITE, OE, CNTL [7:0]”.  The short name CONTROL can then be 
used to label the bus everywhere it appears in the design.  This makes it easy to label a 
complex bus bundle, and change the contents of the bus everywhere it exists by simply 
changing the definition in the bus contents file.  In addition, existing bus contents files from 
other projects or libraries can be included in the current project, making it easier to import 
the bus definitions that have already been used.  Conflicting bus names are resolved in the 
user interface. 

- Hierarchical block generation has been improved.  A schematic popup menu selection is now 
available that invokes a dialog for creating a hierarchical symbol from the active schematic 
sheet.  All signals that contain hierarchical pin connectors (such as IN, OUT, or BI) are 
automatically added as pins to the symbol. 

- Functional Blocks, or FUBs, can now be resized in-place on a schematic.  Select the corner 
of the FUB and stretch it to make it larger.  This makes top-down design more flexible, since 
space for new signals can be easily created.  

- It is now possible to do a regular expression text search-and-replace across an entire design, 
including text within hierarchical blocks.  Any type of text, including attributes, labels, and 
standard text can be modified.  With this new feature, it is easier to rename a net everywhere 
it exists in a design. 

- A new “Place Device” dialog box can be used to place a part directly from the Central 
Library Parts Database (PDB).  This is only used in the DxDesigner/Expedition flow when all 
parts are defined in the Central Library PDB. 

� Enterprise Configuration Enhancements. To better support distributed design 
environments, we have extended the way that libraries and preferences can be specified for 
DxDesigner.  In DxDesigner, whenever a new project is created, a copy of the viewdraw.ini 
file is placed in the new project folder.  This makes it difficult to update existing projects when 
library paths or preference data change.   
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In this release, the viewdraw.ini file can be replaced with a new file called draw.ini. The 
draw.ini file only contains paths to other files, which contain the contents of the viewdraw.ini 
file.  For example, you can create a file called “libraries.ini” and “preferences.ini”.  These files 
may be put on a central server.  The draw.ini file can be used to point to these files.   

If you need to change the libraries or preferences, you can change them on the server and load 
the changes when invoking DxDesigner.  Also, environment variables are supported in the 
paths in the draw.ini file, and in the library paths in the existing viewdraw.ini file.  An example 
of a section of a simple draw.ini file is as follows: 

read $CORP_PREF/preferences.ini 
read division.ini WDIR 
libsr //server1/standardparts/libs.ini 
libsrw ./proj_libs.ini 

 
In this example, the DxDesigner preferences (such as grid size, text size, etc.) may be read 
from a file called preferences.ini that is located where the $CORP_PREF environment variable 
value indicates.  Additional local preferences may be defined by following the WDIR 
environment variable search path and loading the division.ini file.  Finally, the libraries for this 
project may be defined in the file called libs.ini that is located on server1 under the 
standardparts folder. User-defined libraries may then be located in a writable file called 
proj_libs.ini located in the project directory.   

 
It is also possible to define a mapping file that maps variable names, or soft path names, to full 
hard path names.  This provides added flexibility for defining the location of libraries in the 
viewdraw.ini file or the draw.ini file.  A variable, such as $LIBRARY, can be used instead of a 
hard path.  The mapping file, typically located on the network under the your control, can then 
define the actual path to the library. 

This capability can also be used to make it easier for UNIX users and Windows users to work 
in the same DxDesigner project. This is a very flexible and powerful capability that makes 
DxDesigner easier to configure in a distributed, enterprise-wide environment. 

� Partslister. The Partslister has been enhanced to support multiple output formats.  These 
formats include: 

- HTML 

- Microsoft Excel 

- Delimited Text (computer readable format suitable for integration with information 
systems) 

- The current formatted text output 

 
In this release, the Partslister no longer runs the DxDesigner packager. This allows a parts list 
to be generated on designs that are not complete, or on designs that do not have packaging 
data on the symbols.  In the new CDB-based Expedition integration, the DxDesigner packager 
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is not used, so the Expedition packager should be run prior to running the Partslister in order 
to get complete component data. 

� Archive Utility Improvements . The Archive utility is used to collect all the symbols that are 
referenced by a design and copy them to a new project folder, or compress them into a single 
file, so that the project can be easily moved or stored.  The Archive command has a new user 
interface that allows you to select which files become part of the archive.  It can also be 
executed from a command line, so it can more easily be incorporated into project management 
scripts.   

An archive.ini file is  supported.  This file allows you to specify which files and designs should 
be added to the archive based on regular expression mapping.  It can be used to provide 
consistent design archives that contain the required files and exclude the unnecessary files.  The 
Archive utility also modifies the hard paths that exist in the Design Configuration (dproj) 
project file.  Options are provided to generate a PDF view of the design, and to compress the 
archive into a single file. 

� Copy Schematic. It is now possible to copy a section of a schematic from another project to 
your current schematic without adding the project to your library list.  Using the file browser in 
Windows Explorer or Dashboard, select the schematic you want to open and double-click on 
it.  When the schematic is open, select the circuitry you want to copy and copy it to the 
clipboard using the Edit > Copy menu command.  You can then paste the circuitry into your 
current schematic using the Edit >Paste menu command.  This new feature makes it easy to 
reuse schematic data from existing designs. 

� Defect Fixes. A large number of high priority defects have been fixed in this release.  An 
emphasis was placed on improving the performance and stability of DxDesigner.  Please 
contact your customer support representative for status on specific issues. 

Expedition 
The following are the new features for Expedition: 

� HSR (High Speed Option) and Electrical Constraints 

- Support Electrical net constraints (Series elements). 

- Netline Manipulation & delay/length recognizes series elements. 

- Pin-set Topologies for virtual pins in custom and partially-ordered nets. 

- Maximum Length on Restricted layers by Net and Class. 

- Layer restriction and trace width by pin-pairs. 

- Improved HSR Online Hazards reporting. 

- Improved performance for Formulas Online Hazards. 
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- Support for Flooded Signal layer in stackup. 

� Flex Circuit Enhancements  

- Can now slide mixed 45's and arc'd traces properly.  

- Multi-hug trace feature.  

- Group slide multiple hug traces. 

- Improved Assign Net Name feature. 

� Advanced Draw Capability  

- Cutouts in shapes for plane shapes, placement obstructs and draw objects.  

- Padstack Editor now has Draw Tool palette containing almost all Draw functions.  

- Sophisticated trim and extend command.  

- New Scale and Shape Offset commands to provide greater control over resizing draw 
objects. 

- Boolean draw operations - add/subtract shapes.  

- Improved Arc placement. 

� AutoActive Enhancements  

- Support for Package-Type to Package-Type clearances (CES constraints). 

- Support for HP and Sun Platforms (in addition to Windows and Linux). 

- Improved DxD schematic integration. 

- Improved Gloss on tuned diff-pairs. 

- Single plow and Multi-plow combined into single command - automatically recognize diff-
pairs. 

- Advanced Plane Shape Support. 

- Batch DRC by Net. 

- Additional Plane to Trace, Pad and Via clearances. 

- Integration CES with Team PCB. 
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FablinkXE  
 

Following are the new features in FablinkXE 2005: 

� PCB DFF Analysis - Design For Fabrication (DFF) Analysis is a new product option that is 
tightly integrated with Expedition PCB to provide advanced fabrication and manufacturing rule 
DRC that reduces clean up cycles to and from the fabricators which improves quality, 
manufacturability and yield of PCB designs. It is targeted at those companies where controlling 
volume fabrication and manufacturing costs is critical to their business success. It puts DFF in 
the design space where it belongs and not as a post design process based on generated 
manufacturing data, DFF rule sets are defined and Hazards identified and resolved in the PCB 
database using the design data itself. It is available as an option to all configurations of 
Expedition PCB and Fablink XE. 

� PCB design file Support - You can now open an Expedition PCB database directly in Fablink 
XE. Additional functionality such as Detail Views, serachable PDF output, Gerber In and Drill 
In can now all be accessed directly on an Expedition PCB database without consuming an 
Expedition PCB license. Previously Fablink XE functionality could only be accessed in a PCB 
database while acquiring an additional Fablink XE license. 

� IDF 3.0 Support - Fablink XE now performs IDF 3.0 exports at the Panel Level. This enables 
integration between Fablink XE and Mechanical CAD tools.  

� Detail Views - Fablink XE enables you to view detailed design content more clearly by 
employing an opaque “Bring to Front” style view instead of the traditional transparent view. 
This allows you to see exactly what they need to see without seeing all the other parts of the 
design. Individual Detail Views can now also be selected for plotting to a PDF file. 

� Panel Creation Improvements - There are two significant areas where Fablink XE improves 
the panel creation process: 

1. The process of invoking Fablink XE from Expedition PCB for the first time when creating a 
panel design has been significantly improved and automated. All panel directories and 
associated data is created automatically. There is also an option to load a minimum data set 
(manufacturing Outline and Mounting Holes) when placing PCB’s within a Panel design, 
this allows for the parallel preparation of the PCB design and the panel. Instead of having to 
wait for the PCB design to be complete before starting on the panel design, when the PCB 
design is complete, the full data set can be loaded just prior to generating the manufacturing 
output. 

2. Fablink XE now uses design layer validation to allow panel designs to ‘inherit’ the layer 
stackup of the first board placed on the panel. Previously, companies would have had to 
maintain a large library of panel templates that matched the layer stackup of all their PCB’s. 
Now, Fablink XE simply matches the layer stackup of the panel to that of the first board.  
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HyperLynx 7.5 
The following are the new features for HyperLynx 7.5: 

� Free-form schematic editor. A significant upgrade to the LineSim® schematic editor, 
providing an optional way to create new or edit existing LineSim schematics. Full Windows 
support for Copy/Paste of multiple components and transmission-line segments—critical for 
complicated schematics. 

� Interactive board viewer. The BoardSim® board viewer now supports point-and-click 
selection of nets and components, partial plane importing and viewing, interactive crosstalk 
coupling region viewing, and many more interactive enhancements. 

� Batch simulation. A major upgrade for BoardSim users, including driver "round robin" 
support, automated flight time compensation, and sortable spreadsheet output. 

� Simulation enhancements. Support for multiple power supplies, along with both die and pin 
probing. 

� HyperLynx File Editor . All-new multi-purpose text editor for V7.5. 

� New IBIS models. Over 10,000 new models. 

� HyperLynx GHz 

- Via Visualizer. Significant for multi-gigabit signals, Via Visualizer, in BoardSim GHz, 
allows you to view the geometric and electrical details of an individual via or a differential via 
pair, in the board viewer. 

- Free-form schematic editor. Easily instantiate SPICE and scattering parameter (s-
parameter) models. 

- Eye Mask Library . Built-in library of eye masks for a variety of popular SERDES 
technologies. By accessing one easy combo box, you can display the appropriate mask for 
any of approximately 20 bus/link types. 

For a detailed list of new features, refer to the What’s New topic in online Help after software 
installation. 

ICX 
The following are the new features for ICX: 

� CES > ICX constraint integration. From within CES, constraint classes, electrical nets and 

electrical constraints can be sent to ICX. Constraints include MST, TShape, Star and Htree 
topologies, differential pair assignments, length, time of flight and simulated delays, maximum 
crosstalk, static overshoot (high and low), ringback (high and low) and monotonicity. With 
CES open, cross-selection is also available between CES, ICX and Expedition or DxDesigner. 
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For additional information review the documentation within the ICX 
_TOOLKIT\extras\ces2icx directory. 

ICX Pro™ Explorer 
The following are the new features for ICX Pro Explorer: 

� Complete What-if Analysis Environment. ICX Pro™ Explorer enables pre-schematic what-
if signal integrity analysis by exploring and testing various design options. You can vary 
topology, termination, IBIS model selection, board stackup, characteristic impedance and 
many more design parameters. Simulations with these varying parameters are called sweeps 
and may be used to determine the optimum design implementation. Design sensitivity to 
manufacturing tolerances and device variances can be fully explored. 

� Solution Space Exploration. Performing simulation sweeps enables engineers to evaluate 
circuit performance over a range of operating conditions. Solution Space Exploration delivers 
that capability in an easy to use three-dimensional visual form that clearly shows under which 
conditions acceptable circuit performance is achieved. These conditions can then be expressed 
as design constraints to drive the physical implementation of the board. 

� Constraint Definition.  The Constraint Template Editor built into ICX Pro™ Explorer 
provides the same look and feel as CES, enabling designers to capture constraints based upon 
simulation results.  Once established, constraints may be applied to nets or classes of nets 
directly in CES for use in the current project, or they may be saved as generic constraint 
templates to be used in other designs. 

� Proven Simulation Technology. ICX Pro™ Explorer uses the same proven simulation 
technology as ICX®. This proven technology supports IBIS v4.1, including EBDs, SPICE, 
VHDL-AMS and S-Parameter based models. With ICX® simulation technology, designers can 
mix and match model formats, allowing them to use the right models, the first time. 

� Integration into a CES Design Flow. Used standalone, or integrated into a CES design flow, 
ICX Pro™ Explorer provides signal integrity exploration for constraint definition. The 
intellectual property that is captured as design constraints may be re-used design after design. 

� QualityIBIS™. With over 13,500 IBIS models (many created from actual measured devices), 
the QualityIBIS™ library provides you with a comprehensive library of accurate IBIS models 
for use in ICX Pro™ Explorer.  
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I/O Designer 
The following are the new features for I/O Designer: 

� Import PCB Design Wizard. I/O Designer 2005 SPac1 allows you to import an existing PCB 
design from Design Architect, DxDesigner or Design Capture/DesignView. The Import PCB 
Design Wizard guides you through the entire import process.  

� Update Wizard. I/O Designer 2005 SPac1 provides an enhanced update mechanism called the 
Update Wizard. The wizard allows you to merge signal assignments if there are any conflicts. 
The wizard also displays a summary of what has been updated.  

� HPUX operating system support. I/O Designer 2005 SPac1 is available on the HPUX 
platform. 

� Configurable power and ground PCB signal names. I/O Designer 2005 SPac1 allows you 
to choose the PCB signal names for power and ground pins for symbol export.  

� Quartus II 5.0. I/O Designer 2005 SPac1 includes support for Altera Quartus II 5.0. 

� DMS Corporate Library Integration . There is a new option available called “Import symbols 
from DMS”, which is used to retrieve the appropriate component data from DMS and load it 
into I/O Designer. 

� Access Altera DRC's directly from I/O Designer. 

� Support for devices from Altera, Xilinx and Actel, including Xilinx Spartan3e, Altera 
Hardcopy II, and Actel ProASIC3. 

Librarian Flow Manager 
The successful Librarian Flow Manager (LFM) product for the EN release prompted the development 
of a similar product for the Expedition 2005 SPac1 flow. Based entirely on the latest web 
technologies, there is no dependency on WorkXpert. This uses a fully integrated Web-based Part 
Request System, which can be used with a web browser. Moreover, the request management is 
integrated into an extended version of Library Manager (run as “Librarian Flow Manager” from the 
Start Menu or LibrarianFlowManager from the command line), so that this process becomes automatic 
and seamless for the librarian. The major benefits are: 

� Create a part request in DMS, Librarian Flow Manager, or in a web browser.  

� Notification and quick response are ensured by DMS notification mechanisms and the 
integration into the librarian’s usual working environment (that is, Library Manager). 
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� Improved communication. You can log onto your web browser (or in DMS directly) and see 
the status of a request.  

The Librarian Flow Manager extension to Library Manager is supported by DMS LFM EE addon Op 
SW (PN 225515). This license requires the Expedition Library Manager license and the DMS Libr. 
Mgr. Addon Ap SW (PN 226377). The web-based Part Request system is supported by Part Request 
Manager Ap SW-SL (PN 225517). 

Library Manager 
The following are the new features for Library Manager 2005 SPac1:  

� New Library Manager interface. Library Manager 2005 SPac1 supports a new object-centric 
interface supporting both Dx-Expedition and DC-Expedition. 

� HPUX and Solaris Support. Library Manager 2005 SPac1 supports the Solaris and HP-UX 
operating systems (in addition to Linux and Windows). 

� Navigator Tree. Library Manager’s new interface utilizes a navigator tree that provides 
hierarchical tree view of the library objects contained in the Central Library, organized by 
partition or type. This object-centric view clearly shows the relationship and association 
between library objects without having to invoke the different object editors.  In addition to 
displaying the different library object types, the navigator tree provides the following features: 

- Create new part, symbol and cell partitions. 

- Create new library objects within part, symbol and cell partitions and padstack types. 

- View the following associations between objects: 

o Part entries can be expanded to show the associated cell(s) and symbol(s). 

o Cell entries can be expanded to show the associated part(s) and padstack(s).   

o Symbol entries can be expanded to show the associated part(s). 

o Padstack entries can be expanded to show the associated cell(s), pad(s) and hole(s). 

- Edit Library Objects - Library objects can be edited directly from the navigator tree by either 
double-clicking the object or using the popup menu Edit command. This opens the object for 
edit within the appropriate editor. 

- Find Command - This command enables searches for all object types including parts, 
symbols, cells, padstacks, pads and holes. 

� Output PDF. The Output PDF command has been enhanced to support DxDesigner-
Expedition Central Libraries. 
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� Modify Pins. A new Modify Pin Dialog has been added to the Tools pull-down menu, 
enabling librarians to quickly modify pin names or pin numbers of symbols and cells associated 
to parts. 

� DxDataBook Configuration and Parametric Data Editing. Library Manager 2005 SPac1 
supports creating and editing of DxDataBook configurations and the editing of parametric data 
within the associated database. This functionality from Library Studio has been incorporated 
into Library Manager to enable the librarian to edit the configuration and parametric data with 
Library Manager, without invoking another tool. Here are a few highlights of this functionality: 

- The DxDataBook configuration can be setup and edited from Library Manager via the Edit 
DxDatabook Configuration command available on the main Central Library node within the 
navigator tree. 

- Once configured, DxDatabook properties, tables and parametric data can be edited via popup 
commands on each Part partition within the navigator tree which matches the libraries in 
DxDatabook. 

- Parametric Data for individual parts can be edited via the Edit parametric data command 
which is available via the popup menu. The parametric data edited in Library Manager is 
written back to the DxDataBook database. 

� DxDesigner Symbol Wizard. The DxDesigner Symbol Wizard can now be run from Library 
Manager via the Symbol Wizard command, which is available on symbol partition node popup 
menu. 

� New DxDesigner Symbol Editor. A new DxDesigner symbol editor has been incorporated 
into Library Manager. The editor provides comparable capability to DxDesigner/ViewDraw 
and reduces the active project dependencies between Library Manager and DxDesigner. 

� Cell Editor Features 

- Rule Areas in Cells - Rule Areas can now be defined in cells which can be mapped to Rule 
Areas in the PCB design. 

- Associative Dimensioning - A variety of Associative Dimensioning commands are now 
available in the Cell Editor which can be used to dimension specific object types in a cell.  
The dimensions can be defined on Assembly, Silkscreen or user-defined layers. 

- Interactive DRC - You now have the ability to temporarily turn OFF Interactive DRC within 
the Cell Editor. 

- Cutouts - The Subtract command can now be used to define one or more "cutouts" within 
shapes for specific closed draw objects.  For some objects, the outer shape must be filled in 
order to contain cutouts, however, non-filled objects such as the Placement Outline can 
contain cutouts which will affect the area for the Height specification. 

- Draw Enhancements - In addition to Cutout support, the Trim, Extend, Join, Merge & 
Subtract commands have been enhanced in the 2005 SPac1 release.  Also, arcs can be 
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inserted  during the definition of Polylines and Polygons using the right mouse button popup 
menu. 

- Cell Editor support for Padstack Enhancements - The Cell Editor has been enhanced to 
support Padless holes, Padstack Layer Overrides, and Padstack User Layers. 

- Mechanical and Drawing cells - Conductive shapes and Trace objects can now be defined 
in Mechanical cells.  Drawing cells can now contain Trace objects.  

- Jumper Cells - Silkscreen and Assembly Outline data can now be added to Jumper cells. 

� Padstack Editor Features 

- User Layers - Padstack definitions can now include Pads on User-defined layers (as defined 
in Setup Parameters). 

- Layer Overrides - Padstack definitions for Through padstacks (Through Pin, Mounting 
Holes, Vias, etc..) can now include inner-layer overrides (different pads for specified layers). 

- Padless Holes - Through Pin and Mounting Hole padstacks can now be defined using [No 
Pad] for Mount, Internal, and Opposite side pads. 

- Draw Enhancements - Several new Autoactive draw-mode commands were added to the 
Custom Pad editor in the 2005 SPac1 release to better support custom pad and drill symbol 
creation.  The commands include: Move, Scale, Trim, Extend, Join, Merge, and Subtract.  
Also, arcs can be inserted  during the definition of Polylines and Polygons using the right 
mouse button popup menu. 

- X,Y Coordinate Readout - The Custom Pad Editor now includes an X,Y coordinate 
readout at the top of the window. 

� Part Editor Automation  - Support for Read-only Automation has been added to the Part 
Editor. 

� Visual IBIS Editor  - The ICX Pro Visual IBIS Editor can now be launched from the Library 
Manager dialog. 

Quiet Expert 
The following lists the new features in Quiet Expert: 

� Results Classification and Sorting. Major improvements have been made to facilitate better 
handling and classification of analysis results.  Mechanisms now exist to classify severity of 
results and sort the violations according to their severity.  You can also add comments to each 
violation, further increasing the layer of communication between inter-department teams. Refer 
to Chapter 1 in the Quiet Expert User’s Manual for more information. 



 
 

24 Expedition Flow 2005 SPac1 Release Highlights, EXP2005 Spac1 
  June 2006 
 

� History Function. Previous analysis run results can be saved and compared to current analysis 
results to insure previous violations have been fixed properly. Refer to Chapter 1 in the Quiet 
Expert User’s Manual for more information. 

� Added DRCs. Five new DRCs have been added to the analysis set.  These DRCs are in the 
areas of decoupling capacitor analysis, area fill analysis, I/O filtering, differential pair checking, 
and return path checking. Refer to the online help and Chapter 3 in the Quiet Expert User’s 
Manual for more information. 

� Advanced API Additions. Seventeen new APIs have been added to the scan set.   Most are in 
the area of analyzing complex paths, area fills and shielding. Refer to Chapter 2 in the Quiet 
Expert Reference Manual for more information. 

� Automated Flow Support. Automated translation flows for Expedition and Allegro are now 
included in the tool.  Property passing has also been implemented to assist in automation of 
design information from the CAD system to Quiet Expert. Refer to Chapter 2 in the Quiet 
Expert User’s Manual for more information. 

� Board Viewer Enhancements. The board viewer has been enhanced to allow transparent 
viewing of area fills.  This allows you to “see” nets or other structures that exist below an area 
fill.  Additionally, reference designators now appear on the board viewer to assist in the 
investigation of violations. Refer to Chapter 1 in the Quiet Expert User’s Manual for more 
information. 

� Various DR Fixes. There are numerous DR fixes to both the Quiet Expert analysis engine and 
translation process.  These can be found in the Release Notes on SupportNet for more 
information. 

� Crossprobing. Quiet Expert now supports crossprobing to the Expedition toolset 
(PCBExpedition, PCBPlanner and PCBViewer) for nets and parts.  To enable cross-tool 
crossprobing, refer to the Additional Release Notes and Workarounds section in this 
document. 

� Printable Documentation Added. Printable PDF versions of the Quiet Expert User’s Manual 
are available for this release. An InfoHub has been added for web-based searching and 
SupportNet access from Quiet Expert. Refer to the Documentation System Improvements 
topic in this section for more information. 

XtremePCB  
The following are the new features for XtremePCB: 

� CES integration  

� Supports PCB Browser. Realtime updates in read-only browser. 

� Crossprobing to Design Capture. 

� Pin and Gate swapping with back annotation. 
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� Support for HP, Sun and Linux Platforms (in addition to Windows). 

Authorization Codes 

To use the latest releases, you must be on support contracts for these products as of March, 2006. For 
more information about "Exact Access" authorization code formats, see the explanation on 
SupportNet at:  

http://www.mentor.com/supportnet/process_policy/exact_access.html 

You may download your site's existing authorization codes from SupportNet at: 

http://www.mentor.com/supportnet/licenses 

For additional information on licensing, refer to the Licensing Mentor Graphics Software manual. 

Installation Information 
This release uses the Mentor Graphics Standard Installation program. For additional information on 
installation, refer to Managing Mentor Graphics PCB Systems Software manual and the help system 
within the installation software. You can view this manual at the top level of the CD and on 
SupportNet. 

Refer to the Additional Release Notes and Workarounds section later in this document for information 
about any installation issues. 

Support Information 
If you have questions about this software release, please log in to SupportNet. You may search the 
KnowledgeBase with thousands of technical solutions or open a Service Request online at: 

 http://www.mentor.com/supportnet 

If you do not have a SupportNet login, you may easily request one by filling out the short form: 

 http://www.mentor.com/supportnet/quickaccess/SelfReg.do 

For phone support in the United States or Canada, please call 1-800-547-4303. For phone support in 
other locations, please contact your local sales office or distributor. All Customer Support contacts 
can be found on our web site at: 

 http://www.mentor.com/supportnet/support_offices.html 

As mentioned previously in the New Features section above, InfoHubs are HTML information centers 
that organize your sets of documentation and provide information links into SupportNet. InfoHubs 
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provide a combination of HTML- and PDF-based user, reference, process, and release information. 
Refer to that section for InfoHub set up information.  

Changes to the default setting for Internet Explorer on Windows XP SP2 prevents the InfoHub from 
functioning. A fix for this issue is provided in the Additional Release Notes and Workarounds section 
that follows. 

For additional InfoHub release notes and any other workarounds for this release, refer to the 
Expedition Flow 2005 SPac1 Release Notes manual on SupportNet. 

Additional Release Notes and Workarounds 
This section contains additional release notes and workarounds for issues found late in the release 
process for this software release. For a detailed list of all other release notes and any workarounds for 
this release, refer to the Expedition Flow 2005 SPac1 Release Notes manual on SupportNet. 

Is there a significant change for all UNIX and Linux customers using 
DataBook or DxLibraryStudio?  

With the 2005 release, there will be a significant change for all our UNIX and Linux customers who 
use DxDataBook or DxLibraryStudio.  In our previous releases, in order for these products to connect 
to a standard ODBC (Open Database Connectivity) compliant database, we provided a special set of 
third party ODBC drivers.  In the 2005 release, these drivers have been replaced with Mentor-
developed ODBC drivers and direct database connections.  All UNIX and Linux customers who have 
been using the third party ODBC drivers will need to modify their setup to use this new Mentor 
provided solution.  The new drivers will support the following database connection: 

Oracle 9.X 

The drivers may work with other versions of Oracle, but we will only be qualifying DxDataBook and 
DxLibraryStudio on this major version.  We are also introducing an ODBC interface into our 2005 
Library Manager product that will use these new drivers.  Connections to other vendor’s databases 
will no longer be supported on UNIX or Linux.  

Windows-based customers will not have to make any changes to their existing configuration.  
DxDataBook and DxLibraryStudio will continue to work as before.  When making edits to the 
DxDataBook configuration that required an ODBC connection (such as adding a new table), a new 
data source (DSN) will need to be added. 

The web server interface will still be supported on UNIX, Linux, and Windows platforms.  A 
Windows IIS web server is required to publish the database data that DxDataBook reads. 

This new ODBC interface will enable Mentor Graphics to provide a high performance and simple 
database connection for our UNIX and Linux customers.  Please refer to your online help file for 
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information on how to set up the new environment.  Mentor’s Customer Support organization is also 
ready to help with any transition issues that may arise. 

What privileges are required to run the configurator?  

Beginning with the 2005 release, all environment variables set by the configurator are set as System 
variables rather than User variables. (The configurator is an application that sets up your Windows 
environment. For more information, see Chapter 4 in the Managing Mentor Graphics PCB Systems 
Software manual.) The result of this change is that tool installations are configured for all users of a 
given computer. Users who will be installing the tools or running the configurator are required to have 
administrator privileges on the computer; power user privileges are not sufficient. 

Are there any issues running InfoHub from Internet Explorer on Windows XP 
Service Pack2? 

Microsoft has made a change to the default settings for Internet Explorer in Windows XP SP2 that 
disables Javascript from running for locally installed HTML content, thus preventing the InfoHub from 
functioning. To fix this issue, select Tools > Internet Options > Advanced. Scroll down to the 
Security section, and select "Allow active content to run in files on My Computer". Click OK . This is 
not an issue for Mozilla or Netscape users. 

Where can I find application program interface documentation for 
DxDesigner? 

For object, method, property, and event information, please refer to the following online help file 
within your EXP2005 SPac1 installation:  

<install directory>\2005EXP\SDD_HOME\wv\help\vdauto.hlp 
 

For DxDesigner addins automation, please refer to dxdbauto.hlp and dxdmauto.hlp, which are also 
stored at this location. For all other DxDesigner API documentation, please refer to the DxDesigner 
InfoHub. 

What are the recommended Central Library permissions? 

To prevent individuals from making changes to a Central Library but still allow Read access for 
viewing library data, the Central Library must be loaded on a Windows NTFS or Linux/UNIX OS 
disk. All files, whether they are on Windows or Linux/UNIX, should have “Write” permission except 
for individual library files, which can be write-protected as desired to control access. 

Note: Windows users can use the Properties/Security dialog box and Linux/UNIX users can use the 
chmod command to adjust Central Library permissions to corporate guidelines. 

Files that can be permission-controlled are: 

� Common property (centlib.prp) file 
� Padstack library (padstackDB.psk) file located in the Layout folder 
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� Layout template and Panel template files 
� Files in the CellDBLibs, IBISModels, PartDBLibs, and SymbolLibs subdirectories. 
� Parts Manager database (partsmanager.mdb) file (DC/DV to Expedition flow only) 

 
All other files in the central library should remain “Everyone = Change” (read-write) to ensure proper 
operation of the library. The Windows share that allows access to the central library directory from 
remote machines must have permissions set to “Everyone = Full Control”. The share permissions are 
superseded by the individual file permissions. 

 
Are libraries created in EXP2005 SPac1 backward compatable with ISD2004? 

 
Libraries created in EXP2005 are not backward compatible to previous versions. Libraries created in 
previous versions and migrated to EXP2005 cannot be used in prior released versions. 
 
Can I use Librarian Flow Manager – DxDesigner – Expedition with Librarian 
Flow Manager –F1?  

There are data model differences between the Librarian Flow Manager for DxDesigner/Expedition 
included in this release and the Librarian Flow Manager - F1 (for Design Architect/Board Station) that 
was included in the ISD2004 SPac2 release so they cannot be used with the same DMS database.  If 
you have separate DMS databases for each flow, then you can use both products. 

Can I configure DMS to support spaces in my Component Part Numbers and 
Cell catalog names in DMS Librarian and Librarian Flow Manager? 

The default configuration of the DMS Data Model sets special character restrictions based on being 
able to support all Mentor Graphics products.   If you are only using the Expedition 2005 SPac1 Flow, 
then you can remove some of these restrictions to have more flexibility.  Refer to Chapter 2 in the 
DMS Librarian User's Guide for DMS configuration changes to support spaces. 

Are there any known issues with resolution of library paths in the tools? 
Yes. The following are the known issues: 

� Relative path is getting changed to full path in ini files (ex: viewdraw.ini) - This should 
not cause any problem in schematic operations, but when copying the design to another 
location, library paths in ini files of the target location need to examined and corrected. The 
workaround is to define the location map for the project and use soft prefixes to define library 
paths. 

� ViewDraw/Dashboard are resolving hard to soft path incorrectly if one soft path is a 
sub-string of other soft path - No workaround exists. Make sure that no soft path is a 
substring of another soft path. For Example, $EPDLIB' & '$EPDLIB_BACKUP 
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� Library paths in viewdraw.ini are not accessible - Check the viewdraw.ini (or libsr/libsrw 
ini file referenced in draw.ini). Are the soft paths mentioned in the ini file properly defined in 
the location map file? Is the location map getting read from the correct/expected location? 

� Library path in ini files contains $HOME - There should not be any problem if $HOME is 
fixed in your environment. If you are changing your $HOME very often, define $HOME in the 
location map file and use the force option so that the environment value of $HOME does not 
override the value defined in the location map file. Use "MGC_LOCATION_MAP_2 force" as 
the header in your location map file. You cannot use force for individual entries in the location 
map file. 

Are there any issues with defining MGLS_LICENSE_FILE and 
LM_LICENSE_FILE? 

Yes. Beginning with this release, the Configurator sets MGLS_LICENSE_FILE instead of 
LM_LICENSE_FILE to define the location of your licenses. If you already have defined 
LM_LICENSE_FILE to point to your licenses, this results in duplicate entries. Under some 
conditions, these duplicate entries may cause the tool to invoke more slowly. For more information on 
this issue and how to address it, see technote mg59067 (available on SupportNet). 

How do I enable Inter-tool crossprobing between Quiet Expert and 
Expedition? 

 
For the EXP2005 SPac1 release, Quiet Expert now supports crossprobing to the Expedition toolset 
(PCBExpedition, PCBPlanner and PCBViewer) for nets and parts.  To enable cross-tool crossprobing, 
perform the following actions: 

1. For Windows machines, edit the shortcut or command line to change the /syscfg option from 
"QuietExpert" to "QE_Expedition", "QE_Planner", or "QE_Viewer".  This enables the 
application to search and connect to PCB Expedition, Planner, or Viewer, respectively.  Quiet 
Expert can connect to only one tool at any time. 

2. For UNIX platforms, three additional invoke scripts are provided in addition to the standard 
quietexpert script.  These scripts are all located in the 
<install_location>/2005EXP/SDD_HOME/common/<platform>/bin directory and are named 
qe_expedition, qe_planner and qe_viewer. 

3. To set up the applications for crossprobing, first invoke the desired Expedition tool and open 
the design of interest.  Then invoke Quiet Expert using one of the methods described above.  
An indication in the workbench log tab shows that Quiet Expert has connected to the specified 
tool.  Please note that Quiet Expert should already have the default project defined prior to 
invocation or the tool will not properly connect (reference MGC defect 100290486).  This can 
be done by first invoking the tool standalone and setting the appropriate project as active and 
then closing the tool.  This ensures that both tools are using the same data for connection and 
cross-selection. 
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Crossprobing can be toggled on and off using the crossprobe radio buttons located in the application 
toolbar.  These buttons control both crossprobing within the application between the DRC results 
window and the boardviewer, and also between Quiet Expert and external tools as described above.   

When the application is installed and is invoked for the first time, crossprobing is enabled by default.  
This default can then be controlled using the setting in the Tools > Options dialog.  Please note that 
when changing options using the Tools > Options dialog, the setting reverts to an "OFF" mode and the 
default must be manually reset (reference MGC defect 100290490). 

Will .vfm forms continue to work in this release? 

Beginning with the EXP2005.05 release, DxDesigner no longer supports the .vfm format for forms. 
However, forms in the .efm format are still supported. You should rewrite any existing .vfm forms, 
which were used in prior releases, to .efm format for use in this and subsequent releases of 
DxDesigner. 

What version of Allegro does ICX 3.5 support? 

ICX 3.5 supports Allegro 15.2. 

Are there any backward compatibility issues with I/O Designer? 

Design files created in previous versions and migrated to I/O Designer 2005 SPac1 cannot be used in 
prior released versions. 

Are any platforms new for this release? 
Yes. Linux WS 4 and Windows Server 2003 are now supported. For more information, see Appendix 
G: Red Hat Enterprise Linux WS 4 (RHEL4), x86 and Appendix J: Windows Server 2003. 

What version of Exceed does Quiet Expert support in this release? 

Version 9.0 of Exceed terminal emulation software is supported. We do not support versions of 
Exceed earlier than 7.1 and we do not support XVision for Mainwin-ported products. 

Is client/server setup available for the Windows platform? 
Yes. The Server Setup for Client installs is used to install the software to a server-class system where 
multiple Windows client machines actually runs the software across the network. 

The System Administrator should install the desired applications onto the server and select the Server 
Setup for Client Installs > Client/Server Setup option at the same time. The Client/Server Setup option 
installs a file called ClientInstallSetup.exe onto the server during installation. 

To set up the clients, map a network drive to the location on the server where the applications were 
installed and run ClientInstallSetup.exe in the dialog that displays. Enter the path to the location where 
the applications are installed on the server.  
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Supported Platforms         

Overall Notes 

� Specified patches below are minimum levels.  Later versions of the patches are valid, supported 
configurations. 

� Except as noted, all products are supported on all platforms. 

Appendix A: Solaris 8         
 

Solaris 8 (July 2001) with Recommended Patch Bundle 03/16/2004 

Recommended OS Patches: 

� 108131-17 

� 108434-15 

� 108528-29 

� 108576-46   (if Expert3D Graphics Card is installed) 

� 108606-34    (if M64 Graphics Card is installed) 

� 108987-13 

� 109147-38 *  

� 109154-20   (if GFX PGX32 Graphics Card is installed) 

� 109607-01 

� 111111-03 

� 111310-01 

� 112396-02 

� 112564-07   (if XVR-1000 Graphics Card is installed) 

*  This version of patch 109147 must be acquired independently of the above specified patch 
bundle and is required for successful operation of the product. 

  
Kernel Configuration:  Default  

Processor:  Sun Ultra10 333MHz Minimum, SunBlade 2000 900 MHz Recommended 
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Memory:  512 MB Minimum, 1GB Recommended  

Swap Space: 2X the amount of RAM  

/tmp Space: 512 MB Minimum, 1GB Recommended   

Appendix B: Solaris 9        

Recommended OS Patches: 

� Solaris 9 with Recommended Patch Cluster 04/2004 or later 

� 112565-08  (if XVR-1000 Graphics Card is installed) 

� 112622-xx   (if PGX64 Graphics Card is installed) 

 
Kernel Configuration:  Default  

Memory:  512 MB Minimum, 1GB Recommended  

Processor:  Sun Ultra10 333MHz Minimum, SunBlade 2500 1+GHz Recommended 

Swap Space: 2X the amount of RAM  

/tmp Space: 512 MB Minimum, 1GB Recommended   

Appendix C: Solaris 10 
Solaris 10 – FCS Version 

Recommended OS Patches: 

� None 

 
Kernel Configuration:  Default  

Memory:  512 MB Minimum, 1GB Recommended  

Processor:  SunBlade 2000 900MHz Minimum, SunBlade 2500 1+GHz Recommended 

Swap Space: 2X the amount of RAM  

/tmp Space: 512 MB Minimum, 1GB Recommended   
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Appendix D: HP-UX 11.0 (PA-RISC 2.0) 

Recommended OS Patches: 
 

� QPK1100 – Quality Pack for HP-UX 11.00, March 2003 (or newer) 

� PHSS_30965 – ld(1) and linker tools cumulative patch 

Kernel Configuration : Require "CAE/ME/EE Engineering Workstation 64-bit" Tuned Kernel 
Parameters Set, and optionally set the following parameters: 

Maxssize: 401604608 

Maxssiz_64bit: 401604608 

Note: These are optional parameter settings to make the best use of the virtual address space for 
a process.  In the event that an application exhausts its virtual memory space, these settings can 
be reduced a minimum of 83570688 (0x4FB3000) until the application can be accommodated.  
Note that these settings are systemwide and therefore can affect other applications in the 
system.  

Processor: HP C3600  552MHz Minimum,   HP C3750 875MHz Recommended 

Memory:  512 MB Minimum, 1GB Recommended  

Swap Space: 2X the amount of RAM  

/tmp Space: 512 MB Minimum, 1GB Recommended  

HP-UX 11 Kernel Reconfiguration 

Caution: Exit all applications before performing the following steps. Your system automatically 
reboots when you complete the last step.  

1. At the UNIX superuser command prompt, enter the following to display the System 
Administration Manager dialog box: Sam 

2. Double-click the Kernel Configuration  icon. 

3. Double-click the Configurable Parameters icon to display the Kernel Configuration dialog box. 

4. From the Actions pulldown menu, select Apply Tuned Parameters Set to display the Tuned 
Kernel Parameters Set dialog box. 

5. Select CAE/ME/EE Engineering Workstation  in the list and click OK . 
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6. From the File pulldown menu, select Exit  to close the Kernel Configuration dialog box. The 
Create a New Kernel dialog box displays.  

7. Select Create a New Kernel Now. 

Note: If you haven’t already done so, exit all other applications because the next step reboots your 
system. 

8. Click OK . 
 

Appendix E: HP-UX 11i (PA-RISC 2.0) 

Recommended OS Patches: 

� PHNE_25644 - 11i Cumulative ARPA Transport Patch 

� PHSS_30966 – ld(1) and linker tools cumulative patch 

� GOLDAPPS11i – Gold Applications Patches for HP-UX 11i, March 2003 (or newer) 

� GOLDBASE11i – Gold Base Patches for HP-UX 11i, March 2003 (or newer) 

 
Kernel Configuration:  Require "CAE/ME/EE Engineering Workstation 64-bit" Tuned Kernel 
Parameters Set, and optionally set the following parameters: 

 
Maxssize: 401604608 

Maxssiz_64bit : 401604608 

Note: These are optional parameter settings to make the best use of the virtual address space for 
a process.  In the event that an application exhausts its virtual memory space, these settings can 
be reduced to a minimum of 83570688 (0x4FB3000) until the application can be accommodated.  
Note that these settings are systemwide and therefore can affect other applications in the 
system.    

Processor: HP C3600  552MHz Minimum,   HP C3750 875MHz Recommended 

Memory:  512 MB Minimum, 1GB Recommended  

Swap Space: 2X the amount of RAM  

/tmp Space: 512 MB Minimum, 1GB Recommended  
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HP-UX 11i  Kernel Reconfiguration 

Caution: Exit all applications before performing the following steps. Your system automatically 
reboots when you complete the last step.  

1. At the UNIX superuser command prompt, enter the following to display the System 
Administration Manager dialog box:  Sam 

2. Double-click the Kernel Configuration  icon. 

3. Double-click the Configurable Parameters icon to display the Kernel Configuration dialog box. 

4. From the Actions pulldown menu, select Apply Tuned Parameters Set to display the Tuned 
Kernel Parameters Set dialog box. 

5. Select CAE/ME/EE Engineering Workstation  in the list and click OK . 

6. From the File pulldown menu, select Exit  to close the Kernel Configuration dialog box. The 
Create a New Kernel dialog box displays.  

7. Select Create a New Kernel Now. 

Note: If you haven’t already done so, exit all other applications because the next step reboots your 
system. 

8. Click OK . 

Appendix F: Red Hat Enterprise Linux WS 3 (RHEL3), x86 
compatible 

There is no support for Red Hat Enterprise ES or AS. 

This release supports only the x86 (32-bit) version of RHEL3.  It has not been fully tested on the 
AMD64 or IntelEM64T (64-bit) versions.  Customers running AMD64-based systems or Intel 
Pentium4 or Xeon based systems with EM64T capabilities should still use the x86 version of RHEL3. 
This release supports both the base release of RHEL3 and Update 4.  Other RHEL 3 update releases 
(2, 3, & 5) are expected to run, but have not been fully tested. 

OS Version: 

� $ uname –rs 

� Linux 2.4.21-4.EL (Base RHEL 3) 

� Linux 2.4.21-27.EL (RHEL 3 Update 4) 
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Required File Sets:  

Select the following options on the Package Groups offered from install: 

Desktops Package Group: X Window System, GNOME Desktop Environment 

Applications Package Group: Graphical Internet 

Development Package Group: Legacy Software Development 

System Package Group: Printing Support 

Windowing System: 

$ /bin/rpm -q -f /usr/bin/gdm 

gdm-2.4.1.6-2 (Base RHEL 3) 

gdm-2.4.1.6.5 (RHEL 3 Update 4) 

$ /bin/rpm -q -f /usr/X11R6/bin/X 

XFree86-4.3.0.35.EL (Base RHEL 3) 

Xfree86-4.3.0.78.EL (RHEL 3 Update 4) 

Minimum Required OS Patches: None 

Processor: Intel Pentium 3 900MHz Minimum, Intel Pentium 4 2+GHz Recommended 

Memory:  512 MB Minimum, 1GB Recommended 

Swap Space: 2X the amount of RAM  

Kernel Parameters: No changes required. 

Appendix G: Red Hat Enterprise Linux WS 4 (RHEL4), x86 
compatible 

This release supports only the x86 (32-bit) version of RHEL4.  Customers running AMD64-
based systems or Intel Pentium4 or Xeon based systems with EM64T capabilities should still use the 
x86 version of RHEL4. 
This release supports both the base release of RHEL4 and Update 2.  Other RHEL 4 update releases 
are expected to run, but have not been fully tested. 
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OS Version: 

� $ uname –rs 

� Linux 2.6.9-5.EL #1 (Red Hat Enterprise Linux 4 Base Version) 

� Linux 2.6.9-11.EL #1 (Red Hat Enterprise Linux 4 Update 2) 

Required File Sets:  

Select the following options on the Package Groups offered from install: 

Desktops Package Group: X Window System, GNOME Desktop Environment 

Applications Package Group: Graphical Internet 

Development Package Group: Legacy Software Development 

System Package Group: Printing Support 

Windowing System: 

$ /bin/rpm -q -f /usr/bin/gdm 

gdm-2.6.0.5-6  (RHEL 4 Base Version)   

gdm-2.6.0.6-7  (RHEL 4 Update 2)   

$ /bin/rpm -q -f /usr/X11R6/bin/X 

xorg-x11-6.8.1-23 (RHEL 4 Base version) 

xorg-x11-6.8.2-1.EL.13.15 (RHEL 4 Update 2) 

Minimum Required OS Patches: None 

Processor: Intel Pentium 3 900MHz Minimum, Intel Pentium 4 2+GHz Recommended 

Memory:  512 MB Minimum, 1GB Recommended 

Swap Space: 2X the amount of RAM  

Kernel Parameters: No changes required. 

IT Administration Notes: 

Enable TCP connections for X via the gdm.conf file using the following instructions: 
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1. From the desktop (after OS install),  edit /etc/X11/gdm/gdm.conf and change the line that reads 

#DisallowTCP=true  to 
DisallowTCP=false 
 

2. Reboot System. 

Optionally disable firewall and SELinux  (This option is needed for XtremePCB, and may be needed 
for other system level administrative activities.) 

1. Applications->SystemSettings-> Security Level 

� Firewall Options tab: 

Security Level: Disable firewall 

� SELinux tab 

Uncheck “Enabled (Modification Requires Reboot)” 

2. Reboot System 

Appendix H: Windows 2000       
Additional OS Patches: Service Pack 4 (plus any Web Updates or Hotfixes to this service pack 
available through Microsoft) 

Processor: Intel Pentium 3 900MHz Minimum, Intel Pentium 4 2+GHz Recommended 

Memory:  512 MB Minimum, 1GB Recommended  

Virtual Memory:  2X the amount of RAM 

Appendix I: Windows XP Professional    
Additional OS Patches:  

Either of the following two configurations is supported: 

� Service Pack 2 

� Service Pack 1a (plus any Web Updates or Hotfixes to this service pack available through 
Microsoft). Note:  There is no benefit to installing SP1a if you are already running Windows XP 
SP1. Microsoft does not recommend that you install SP1a if you are already running SP1. 

Microsoft Windows XP Pro Service Pack 2 (optionally load all current updates via Windows Update) 
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Processor: Intel Pentium 3 900MHz Minimum, Intel Pentium 4 2+GHz Recommended 

Memory:  512 MB Minimum, 1GB Recommended  

Virtual Memory:  2X the amount of RAM 

Appendix J: Windows Server 2003   
Additional OS Patches:  

The following configuration is supported: 

� Microsoft Windows Server 2003, Standard Edition Service Pack 1 with all current updates via 
Windows Update. 

While there is no known issue with running Windows Server 2003, Enterprise Edition or Windows 
Server 2003, Datacenter Edition, the product has not been tested with these versions, and therefore is 
officially unsupported. 

Windows Server 2003 x64 Editions and Windows Server 2003 for Itanium-based Systems are not 
supported. 

Processor: Intel Pentium 3 900MHz Minimum, Intel Pentium 4 2+GHz Recommended 

Memory:  512 MB Minimum, 1GB Recommended  

Virtual Memory:  2X the amount of RAM 


